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Preface

The Sun StorEdge Traffic Manager 3.1 Software User’s Guide provides instructions for

using the Sun StorEdge™ Traffic Manager software in IBM AIX 4.3.3 ML11 and 5.1

ML4, HP-UX 11.0 and 11.i, Microsoft Windows NT Service Pack 6a, Microsoft

Windows 2000 service pack 4, and Microsoft Windows 2003 operating environments.

This guide is designed for use with the documentation that came with your storage

device and is written for experienced system administrators of the supported

operating environments and related disk storage systems.

Throughout this guide, storage device is used to designate the storage devices

supported in this release. The supported devices are:

■ Sun StorEdge 6020 array with 2.1x Firmware Asymmetric Explicit LUN Failover

(ELF)

■ Sun StorEdge 39xx Asymmetric ELF

■ Sun StorEdge 6910 and 6960 Symmetric

■ Sun StorEdge 6120 array Asymmetric ELF

■ Sun StorEdge 6320 System Asymmetric ELP

■ Sun StorEdge 3510 FC array Symmetric

■ Sun StorEdge 99xx Symmetric only

The screen shots used throughout this guide were created on a Hewlett-Packard

HP_UX operating system. The information (device names, path names, and HBA

names) on your screens will be generated by your operating system and may look

different. However, the function of the screen will be as described in this guide.

Before You Read This Guide

To fully use the information in this guide, you must have thorough knowledge of the

topics described in these documents:



xiv Sun StorEdge Traffic Manager 3.1 Software User’s Guide • October 2003

■ The Sun StorEdge Traffic Manager 3.1 Software Installation Guide that supports your

operating environment

■ The documentation that came with your storage device

How This Guide Is Organized

This guide is organized as follows:

Chapter 1 provides an overview of the Sun StorEdge Traffic Manager Software.

Chapter 2 explains the Sun StorEdge Traffic Manager Software GUI.

Chapter 3 explains the Sun StorEdge Traffic Manager command line interface.

Chapter 4 describes the error messages that can be issued during software operation.



Preface xv

Typographic Conventions

Related Documentation

Typeface *

* The settings on your browser might differ from these settings.

Meaning Examples

AaBbCc123 The names of commands, files,

and directories; on-screen

computer output

Edit your.login file.

Use ls -a to list all files.

% You have mail .

AaBbCc123 What you type, when contrasted

with on-screen computer output

% su

Password:

AaBbCc123 Book titles, new words or terms,

words to be emphasized.

Replace command-line variables

with real names or values.

Read Chapter 6 in the User’s Guide.

These are called class options.

You must be superuser to do this.

To delete a file, type rm filename.

Application Title Part Number

Late-breaking Information Sun StorEdge Traffic Manager 3.1
Software Release Notes for IBM AIX,
Hewlett-Packard HP-UX, and Microsoft
Windows NT, 2000, and 2003 Operating
Systems

817-4687-10

Installation Sun StorEdge Traffic Manager 3.1
Software Installation Guide For the IBM
AIX Operating System

817-3679-10
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Accessing Sun Documentation

You can view, print, or purchase a broad selection of Sun documentation, including

localized versions, at:

http://www.sun.com/documentation

Contacting Sun Technical Support

If you have technical questions about this product that are not answered in this

document, go to:

http://www.sun.com/service/contacting

Installation Sun StorEdge Traffic Manager 3.1
Software Installation Guide For the
Hewlett Packard HP-UX Operating
System

817-3680-10

Installation Sun StorEdge Traffic Manager 3.1
Software Installation Guide For Microsoft
Windows NT, 2000 and 2003 Operating
Systems

817-3681-10

SAN configuration Sun StorEdge SAN Foundation
Configuration Guide

817-0057-10

Application Title Part Number
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Sun Welcomes Your Comments

Sun is interested in improving its documentation and welcomes your comments and

suggestions. You can submit your comments by going to:

http://www.sun.com/hwdocs/feedback

Please include the title and part number of your document with your feedback:

Sun StorEdge Traffic Manager 3.1 Software User’s Guide for IBM AIX, Hewlett-Packard,

and Microsoft Windows NT, 2000, and 2003 Operating Systems, part number 817-3678-10
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CHAPTER 1

Sun StorEdge Traffic Manager
Software Overview

This chapter contains the following topics:

■ “About the Sun StorEdge Traffic Manager Software” on page 1

■ “Hub and Switch Configurations” on page 4

About the Sun StorEdge Traffic Manager
Software

The Sun StorEdge Traffic Manager software is a system for managing multiple paths

to storage devices. The Sun StorEdge Traffic Manager software is comprised of a

graphical user interface application, a command line interface application and

system device drivers for managing the multiple paths. If a failure occurs in one host

data path, the Sun StorEdge Traffic Manager software automatically detects the

failure and provides continuous access to your data through an alternate data path.

Refer to Chapter 2 of this guide for a description of using the Sun StorEdge Traffic

Manager software GUI and Chapter 3 for a description of using the command line

interface.

System Configuration

The Sun StorEdge Traffic Manager system maintains and presents storage system

configuration information. FIGURE 1-1, shows an example of using the Sun StorEdge

Traffic Manager GUI application to access the Sun StorEdge Traffic Manager system.
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Each storage device and the LUNs associated with it are shown on the left side of

the window and the paths and host bus adapters (HBA) system names are shown on

the right.

FIGURE 1-1 Host Data Paths Between HBAs and Storage Devices

In your operating environment, the device names, drive names, path designations,

and HBA names may differ from the items shown in FIGURE 1-1.

Asymmetric Device Path Management

Description

For Asymmetric devices, the following description of failover and failback

operations apply.

Failover

A LUN on a asymmetric device can only have one active controller at a time. The

remaining controller is known as the passive controller. Paths to the active controller

are known as active paths. Paths to the passive controller are known as passive

paths. The process by which a LUN may force a passive controller to become its

active controller is known as LUN failover. Upon successful LUN failover, passive

paths to a controller become active and previously active paths become passive. On

the Sun StorEdge T3 and Sun StorEdge 6120 arrays, failover is implemented per

device volume. Therefore, if volume slicing is enabled, there may be multiple LUNs

on the volume affected by a failover. Also in a multi-initiator environment, a LUN

failover on one host is detected by all other hosts using LUNs on the same volume.



Chapter 1 Sun StorEdge Traffic Manager Software Overview 3

LUN failover can be initiated by both automatic and manual means.

Automatic Failover by Error Detection

If a path receives errors and fails, it is marked as Down or Removed. If all the active

paths for a LUN are marked down and there are remaining passive paths, the driver

automatically causes a LUN failover to activate the passive paths.

Manual Failover Initiated by the User activate Command

The user may use the activate command to manually initiate a LUN failover by

activating a passive path. Previously active paths will become passive. If the LUN is

a slice on a volume, all LUNs on that volume will failover for all hosts.

Manual Failover Initiated by User restore Command

On some devices, a LUN may have a default active controller. This is known as the

preferred controller. A restore command will attempt to cause a failover of all

LUNs that do not currently have active paths to their preferred controller.

Automatic Failback Initiated by an Automatic Restore

If the driver recognizes that a down path becomes passive, an automatic restore
command may occur. This is currently known as autofailback. The autofailback

parameter must be set to enabled in order for this to occur.

Note – Autofailback is not supported in a multi-initiator environment.

To learn how to perform failback, see “Setting the Failback Mode” on page 31.

Symmetric Device Path Management Description

For Symmetric devices, all paths are active unless a path is unhealthy, in which case

it is marked as Down or Removed. There is no failover or failback, an unhealthy

path is just not used. Load balancing occurs across all active paths to improve

performance by using all available paths to a storage device.
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Hub and Switch Configurations

The Sun StorEdge Traffic Manager software works with storage device

configurations that include hubs and switches. For a list of compatible hubs, see The

Sun StorEdge Traffic Manager 3.1 Software Installation Guide for your operating

environment.

For information about configuring a storage device with switches, refer to the

documentation for the switch you are using.

Description of Specific Fields

Throughout its operation, the Sun StorEdge Traffic Manager software presents

information about devices, properties, paths, and metrics using specific fields.

TABLE 1-1 lists the specific fields and a description of the contents.

TABLE 1-1 Specific Fields

Specific Field Contents

Auto Failback Controls how the software responds when a failed path comes back

online or is re-established. When a failed path is repaired or returns

from a down state, it is always re-enabled but not always activated.

When Auto Failback is enabled and the path is the preferred path, it

is automatically re-activated. Note that automatic failback is only

supported in a single-host environment.

Blocks Transferred Displays the number of I/O read or write blocks transferred to and

from the storage device. These values are only maintained from the

last host boot. They are not persistent across a reboot of the host.

Capacity Storage capacity of the LUN.

Device Description Displays one of the Sun devices in the following list:

• Sun StorEdge 6020 array with 2.1x Firmware Asymmetric Explicit

LUN Failover (ELF)

• Sun StorEdge 39xx Asymmetric ELF

• Sun StorEdge 6910 and 6960 Symmetric

• Sun StorEdge 6120 array Asymmetric ELF

• Sun StorEdge 6320 System Asymmetric ELP

• Sun StorEdge 3510 FC array Symmetric

• Sun StorEdge 99xx Symmetric only
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Enabled or Active The state field can contain the following states:

• ACTIVE —is Enabled, yes Active, yes

• PASSIVE—is Enabled, yes Active, no

• ADMIN—is Enabled, no Active, no

• DOWN—is Enabled, no Active, no

• TRANSITIONING—state is changing

• UNKNOWN—cannot be determined

• REMOVED—is Enabled, no Active, no

Error Returns A list of all the Error returns from the Sun StorEdge Traffic Manager

software is in Chapter 4.

Firmware Revision Displays the high-level firmware that is currently active on the

storage device.

HBA Displays the name of an HBA according to the conventions of your

operating environment.

Host Requests Displays the number of I/O requests that the upper-level drives

have given to the Sun StorEdge Traffic Manager software. These

values are only maintained from the last host boot. They are not

persistent across a reboot of the host.

I/O Errors Displays the number of errors handled by the failover driver for the

specified LUN. These values are only maintained from the last host

boot. They are not persistent across a reboot of the host.

IP Address Displays the management IP address for the Sun StorEdge storage

device. The IP address is only exposed for select Sun StorEdge

storage products that provide this information in-band to the host

device drivers.

Log Level Determines the messaging detail that is sent to the host system log.

Multiple log levels can be OR’ed together for multiple log levels. All

log levels can be turned on by specifying 0x1F .

LUN Name Field The operating-system specific name for the specified LUN. If the

operating LUN name cannot be determined, it is presented as a LUN.

LUN state Choices are:

• UP

• Down

• Waiting for an active path

• Transitioning

• Removed

• Unknown

LUN Unique ID Uniquely identifies a LUN connected to the host.

Nexus Name Displays the nexus name for the HBA to storage device controller.

The nexus name is defined by the Sun StorEdge Traffic Manager

software. The format varies with each supported operating system.

TABLE 1-1 Specific Fields (Continued)

Specific Field Contents
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Outstanding I/Os Displays the number of I/Os that have been sent to the device and

have not been completed. This value is comparable to the I/O queue

depth from this host to a given LUN. These values are only

maintained from the last host boot. They are not persistent across a

reboot of the host.

Pathing mode Asymmetric or symmetric,

Poll Rate Healthy poll rate determines how often the software checks the

status of paths that are not down and are currently available.

Unhealthy poll rate determines how often the software checks the

status of paths that are down.

Serial Number Contains the hardware serial number for this product. If there is

more than one serial number for the product, the first serial number

found is displayed.

Single Character

Column

On the left side of the information produced by the command-line

interface is a column that has an asterisk (*) as the column head. This

column contains warning and error states if they exist. The possible

values in this column are:

‘ ‘ — No warnings

‘X’— The path is down or removed

‘!’— The path is not active and is the preferred path

‘!’— The path is in admin mode

‘-’— The path is in transition

‘?’— The path is in an unknown state

Storage Device Defined as a collection of LUNs contained by a specific storage

product (a Sun StorEdge 6120 partner pair). If a well-defined storage

system cannot be determined, LUNs are put in collections based on

their SCSI INQUIRY VENDOR/PRODUCT/SERIAL values. For

example, this would occur for a third-party storage device that is

attached though Sun Solaris Open-MpxIO.

Unique ID A Sun internal ID that is used to associate LUNs to a specific storage

device.

Worldwide Name

(WWN)

A Sun internal identification that is used to associate LUNs to a

specific storage device.

TABLE 1-1 Specific Fields (Continued)

Specific Field Contents
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CHAPTER 2

Explaining the Sun StorEdge Traffic
Manager GUI Software

This chapter describes the Sun StorEdge Traffic Manager GUI software and its uses.

Topics in this chapter include:

■ “Understanding the Sun StorEdge Traffic Manager GUI” on page 7

■ “Basic Operation” on page 11

■ “Manipulating the Data Path” on page 11

■ “Getting Storage Device Information” on page 21

■ “Setting the Software Preferences” on page 28

Understanding the Sun StorEdge Traffic
Manager GUI

This section describes the Sun StorEdge Traffic Manager GUI and explains the

purpose of the various icons meanings.

When the Sun StorEdge Traffic Manager GUI starts, the Sun StorEdge Traffic

Manager window, as shown in FIGURE 2-1, is displayed. In a device tree on the left of

the window is a list of supported storage devices attached to the current host and

the LUNs contained in each of those storage devices. The first storage device is

always selected and the information about that storage device is displayed on the

right of the window. The right of the window contains:

■ Type of device

■ Unique ID

■ IP address

■ Firmware revision

■ Name of the host the storage device is attached to
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The names used in the device tree are the operating system-specific names for the

particular storage devices and LUNs.

If the name of a storage device cannot be obtained, “storage device” is used for the

name on the left of the window. If a LUN name cannot be obtained, “LUN” is used

for the LUN name.

If the Sun StorEdge Traffic Manager driver or library files are not installed and

working properly, the left of the window displays a message indicating the improper

installation.

If no storage devices are attached, the left of the window displays a message

indicating that no storage devices are attached.

FIGURE 2-1 The Sun StorEdge Traffic Manager Software Window
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Storage Device and LUN Icons

The left of the Sun StorEdge Traffic Manager GUI window shows storage device and

the LUNs contained in each using the following icons.

• The name of the storage device known to the Sun StorEdge

Traffic Manager software.

• The LUNs that are contained in each of the storage devices.

Removed icon for a path, storage device, or LUN that is removed

and needs attention.

The following status icons are layered on the storage device or LUN icons for a

storage device or LUN that needs attention. For example, if a LUN is not able to

allow I/O due to path conditions or it contains a broken path, the critical icon is

layered on top of the LUN icon and storage device icon. Or, if a LUN has failed

over and not in its normal state, the minor icon is layered on top of the LUN and

the storage device icon.

• Minor icon for a path, storage device, or LUN that might need

attention.

• Critical icon for a path, storage device, or LUN that is down or

broken and needs attention.

• Icon that is displayed if the path is in transition.
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Path Table Icons

The right of the window in FIGURE 2-1 contains information about a storage device if

one is selected, or a path table for a LUN when a LUN is selected. The following

status icons are displayed for the LUN in the table when that LUN needs attention.

For example, if a preferred path has failed over, a minor icon is displayed for that

path in the path table. If a path is down or broken, a critical icon is displayed.

• Minor icon for a path that might need attention.

• Critical icon for a path that is down or broken and needs

attention

• Removed icon for a path, storage device, or LUN that is

removed and needs attention.

• Icon that is displayed if the path is in transition.

• Icon that is displayed if the status of the path is unknown
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Basic Operation

Updating the Path Status

When the Sun StorEdge Traffic Manager software detects a change in the status for a

path (for example, a path goes down, fails over, or the user disconnects a cable), it

sends a message to the Sun StorEdge Traffic Manager GUI to update. The GUI gets

the updated information from the software and displays the new status.

The information displayed by the GUI automatically updates when the state of a

path changes. However, if you don’t want to wait (for example, a long poll rate has

been specified or you think the data displayed is out-of-date), you can quickly

update the information displayed by the GUI in one of two ways:

■ Choose Refresh under the File menu.

■ Press the F5 key.

Manipulating the Data Path

This section describes how to manipulate the data path between the host and the

storage device. The following changes can be made to the data path:

■ Removing a data path from admin mode

■ Putting a data path into admin mode

■ Activating a data path

■ Activating all preferred data paths for a storage device

■ Activating all preferred data paths for a particular LUN

■ Removing all data paths to a particular HBA from admin mode,

■ Putting all data paths to a particular HBA into admin mode,

Data Path States

The Path table contains a column labeled State. Each path listed in this column will

have the following states:

■ Active, it the path is active

■ Passive, if the path is healthy but not active
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■ Admin, if the path has been put into admin mode and is not being considered for

I/O

■ Transition, if the state of the path is changing

■ Down, if the path is broken and needs repair

■ Unknown, if the state of the path cannot be determined

■ Removed

Putting a Single Data Path into Admin Mode

Putting a data path into admin mode prevents all normal I/O from using the path.

For example, you might want to put a path in admin mode to perform maintenance

on a component in the data path.

Putting a path in admin mode is not allowed if there are no other active data paths

available for the same LUN.

A path that is down, for example, has a defective cable, can be put into admin,

which will stop any I/O from using the path. However, if the cable is not repaired,

the path stays down after being removed from admin mode.

See “Removing a Single Data Path From Admin Mode” on page 14 to remove a data

path from admin mode.

There are two methods in the Sun StorEdge Traffic Manager GUI to put a single data

path into admin mode.

▼ Putting a Single Data Path into Admin Mode (Method 1)

1. From the device tree on the left of the window, select the LUN that contains the
path you want to put into admin mode.

2. From the path table on the right of the window, select the path that you want to
put into admin mode.
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3. Choose To Admin from the Path pull-down menu.

FIGURE 2-2 Using the Path Menu Button to Put a Single Path Into Admin Mode

▼ Putting a Single Data Path into Admin Mode (Method 2)

1. From the device tree on the left of the window, select the LUN that contains the
path you want to put into admin mode.

2. From the path table on the right of the window, right-click on the path you want
to put into admin mode.

3. Choose Put this path into admin mode from the pull-down menu.

FIGURE 2-3 Using the Path Table to Put a Single Path into Admin Mode

For both methods, a dialog box is displayed to indicate the path is being put into

admin mode and that you should wait until the operation is complete.
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Removing a Single Data Path From Admin Mode

Removing a data path from admin mode does not guarantee that the path will

become active.

A path that is down, for example, has a defective cable, stays down after being

removed from admin mode if the cable is still defective.

See “Activating Data Paths” on page 15 to make a healthy data path active.

In the Sun StorEdge Traffic Manager software GUI, there are two methods to remove

a single data path from admin mode.

▼ Removing a Single Data Path From Admin Mode (Method
1)

1. From the device tree on the left of the window, select the LUN that contains the
path you want to enable.

2. From the path table on the right of the window, select the path that you want to
remove from admin mode.

3. Choose Remove Admin from the Path pull-down menu.

FIGURE 2-4 Using Path Menu to Remove a Single Path From Admin Mode

▼ Removing a Single Data Path From Admin Mode (Method
2)

1. From the device tree on the left of the window, select the LUN that contains the
path you want to remove from admin mode.

2. on the right of the window in the path table, right-click on the path you want to
enable.
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3. Choose Remove this path from admin mode from the pull-down menu.

FIGURE 2-5 Using the Path Table to Remove a Single Path From Admin Mode

For both methods, a dialog box is displayed to indicate that the path is being

enabled and that you should wait until the operation is complete.

Activating Data Paths

A data path must be healthy but not active (passive) before you can activate it.

There are two methods in the Sun StorEdge Traffic Manager GUI to activate a data

path.

▼ Activating a Single Data Path (Method 1)

1. From the device tree on the left of the window, select the LUN that contains the
path you want to activate.

2. From the path table on the right of the window, select the path that you want to
activate.
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3. Choose Activate from the Path pull-down menu.

FIGURE 2-6 Using the Path Menu to Activate a Single Data Path

▼ Activating a Single Data Path (Method 2)

1. From the device tree on the left of the window, select the LUN that contains the
path you want to activate.

2. On the right side of the window in the path table, right-click on the path that you
want to activate.

3. Choose Activate this data path from the pull-down menu.

FIGURE 2-7 Using the Path Table to Activate a Single Data Path

For both methods, a dialog box is displayed to indicate that the path is being

activated and that you should wait until the operation is complete.
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Activating All Preferred Paths for a Storage

Device

You can activate all preferred paths for a particular storage device if that device has

preferred paths. Preferred paths are determined by the Sun StorEdge Traffic

Manager software and are based on device type and connection. The preferred path

is the optimal path to a device. The preferred path must be healthy but not active

(passive) before it can be activated.

▼ Activating All Preferred Paths for a Storage

Device

1. Select a storage device in the device tree on the left of the window.

2. Choose Activate preferred paths from the Device pull-down menu

FIGURE 2-8 Using the Device Menu to Activate All Preferred Paths

A dialog box is displayed to indicate that all preferred paths are being activated and

that you should wait until the operation is complete.

Putting All Paths to a Particular HBA into Admin

Mode

If you want to perform maintenance on a specific HBA, to which you have several

storage devices connected, you can put all paths to a particular HBA into admin

mode.

In the Sun StorEdge Traffic Manager GUI, there are two methods to put all paths to

a particular HBA into admin mode.
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▼ Putting All Paths To a Particular HBA into Admin Mode
(Method 1)

1. From the device tree on the left of the window, select the LUN that has a path
using the particular HBA you are interested in.

2. From the path table on the right of the window, select the path that is using the
HBA you are interested in.

3. Choose Put all paths in admin mode from the HBA pull-down menu.

FIGURE 2-9 Using the HBA Menu To Put All Paths To a Particular HBA Into Admin Mode

▼ Putting All Paths To a Particular HBA Into Admin Mode
(Method 2)

1. From the device tree on the left of the window, select the LUN that has a path
using the particular HBA you are interested in.

2. On the right of the window in the path table, right-click on the path that is using
the HBA you are interested in.



Chapter 2 Explaining the Sun StorEdge Traffic Manager GUI Software 19

3. Choose Put all paths to this HBA into admin mode from the pull-down menu.

FIGURE 2-10 Using the Path Table to put All Paths to a Particular HBA into Admin Mode

For both methods, a dialog box is displayed to indicate that all paths to a particular

HBA are being put into admin mode and that you should wait until the operation is

complete.

Removing All Paths to a Particular HBA From

Admin Mode

You can remove from admin mode all paths to a particular HBA after you have

swapped out or repaired the component in the path to this HBA.

In the Sun StorEdge Traffic Manager GUI, there are two methods to remove all paths

to a particular HBA from admin mode.

▼ Removing All Paths To a Particular HBA From Admin
Mode (Method 1)

1. From the device tree on the left of the window, select the LUN that has a path
using the particular HBA you are interested in.

2. From the path table on the right of the window, select the path that is using the
HBA you are interested in.
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3. Choose Remove all paths from admin mode from the HBA pull-down menu.

FIGURE 2-11 Using the HBA Menu to Remove all Paths to a Particular HBA From Admin
Mode

▼ Removing All Paths To a Particular HBA From Admin
Mode (Method 2)

1. From the device tree on the left of the window, select the LUN that has a path
using the particular HBA you are interested in.

2. On the right of the window in the path table, right-click on the path that is using
the HBA you are interested in.

3. Choose Remove all paths to this HBA from admin mode from the pull-down
menu that is displayed.

FIGURE 2-12 Using the Path Table To Remove All Paths To a Particular HBA From Admin
Mode

For both methods, a dialog box is displayed to indicate that all paths to a particular

HBA are being removed from admin mode and that you should wait until the

operation is complete.



Chapter 2 Explaining the Sun StorEdge Traffic Manager GUI Software 21

Getting Storage Device Information
When the Sun StorEdge Traffic Manager GUI starts, the storage device and the

operating system-specific names for the storage device are selected on the left of the

window. On the right of the window is detailed information about that storage

device.

To get this detailed information about any storage device shown on the left of the

window, select that storage device by clicking on it.

FIGURE 2-13 Storage Device Information

Getting LUN Information

To get information about a particular LUN, select that LUN icon on the left of the

window by clicking on it. The LUN information is displayed on the right of the

window. Some of the information is in a path table and other information is shown

above the table. The following information is above the table:

■ The operating system-specific name of the LUN

■ Unique ID of the LUN

■ The serial number

■ Type of pathing mode: symmetric or asymmetric

■ LUN state

■ Storage capacity of the LUN
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In the path table, all paths to the LUN are displayed. If any path needs attention,

either the minor icon or the critical icon is displayed beside the information in the

path table.

FIGURE 2-14 Getting LUN Information

▼ Getting LUN Statistics

To get I/O statistics for a particular LUN, do the following steps:

1. From the device tree on the left of the window, select the LUN for which you want
statistics.

2. Choose Statistics from the LUN pull-down menu.

FIGURE 2-15 Selecting LUN Statistics
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A dialog box is displayed containing the statistics of the LUN.

FIGURE 2-16 LUN Statistics

▼ Getting Host Bus Adapter Properties

To get information about the properties of a host bus adapter (HBA) that is in the

path of a particular LUN, do the following steps:

1. Select the LUN from the device tree on the left of the window that has a path
using the particular HBA you are interested in.

2. On the right of the window, select the path in the path table that is using the HBA
you are interested in.

FIGURE 2-17 Selecting the HBA Path
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3. Choose Properties from the HBA pull-down menu.

FIGURE 2-18 Selecting HBA Properties

A dialog box is displayed containing the properties of the HBA.

FIGURE 2-19 HBA Properties

Getting Path Statistics

In the Sun StorEdge Traffic Manager software GUI, there are two methods to get the

statistics for a specified path.

▼ Getting Path Statistics (Method 1)

1. From the device tree on the left of the window, select the LUN that contains the
path you are interested in.
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2. From the path table on the right of the window, select the path for which you
want to view statistics.

FIGURE 2-20 Selecting the Path for Path Statistics

3. Choose Statistics from the Path pull-down menu.

FIGURE 2-21 Choosing Path Statistics
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A dialog box is displayed that contains the I/O statistics.

FIGURE 2-22 Path Statistics

▼ Getting Path Statistics (Method 2)

1. From the device tree on the left of the window, select the LUN that contains the
path you are interested in.

2. On the right of the window in the path table, right-click on the path for which
you want to view the statistics.

FIGURE 2-23 Selecting the Path for Path Statistics
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3. From the pull-down menu, choose Display statistics for this path.

FIGURE 2-24 Path Statistics Pull-Down Menu

A dialog box is displayed that contains the I/O statistics.

The statistics in the dialog box do not change dynamically, but you can click on the

Refresh button and get updated statistics.

FIGURE 2-25 Path Statistics Dialog Box

▼ Getting On-Line Help

● Choose User’s Guide from the Help pull-down menu to display the Sun StorEdge
Traffic Manager 3.1 Software User’s Guide for online help. Select Installation and
Troubleshooting Guide to display the installation guide for your operating
system.



28 Sun StorEdge Traffic Manager 3.1 Software User’s Guide • October 2003

FIGURE 2-26 Choosing User’s Guide for Online Help

If you select About Sun StorEdge Traffic Manager from the Help pull-down menu,

you can get such information as the software version and the overall application

version (as well as the copyright notice).

Setting the Software Preferences

This section describes how to configure the preferences for the Sun StorEdge Traffic

Manager software. The following preferences can be configured:

■ Logging level

■ Failback mode

■ Poll rates

Setting the Logging Level

Click Help from the task bar and select User’s guide to see the Sun StorEdge Traffic
Manager 3.1 Software Installation Guide for your operating environment for a

description of the logging levels.

The logging level is determined for the Sun StorEdge Traffic Manager software on a

per system basis. That is, setting the logging level sets it for all devices attached to

the specified host. This enables you to control what level of messages you want to

put into the operating system’s log file.
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▼ Setting the System Logging Level

1. Choose Preferences from the File pull-down menu.

FIGURE 2-27 Choosing Preferences for the Logging Level

2. Select the desired log level options in the Host Preferences dialog box.

See FIGURE 2-28 for a list of the logging levels and the installation guide for your

operating system for a description of each level. The installation guide is selected

from the Help pull-down menu.

FIGURE 2-28 Setting the Logging Level
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3. Click OK for the selected items to take effect.

If you do not want to save the changes made, click the Cancel button.

If you want to see the default settings for the Log Levels, click the Factory Defaults

button. The factory defaults will not take effect unless you click OK.

Note – Be aware that by clicking the Factory Defaults button, you are also setting

Failback Mode and Poll Rate to the factory default settings.

Setting the Failback Mode

After the failover of a data path, what is specified for the failback mode determines

how the data path is changed from the alternate data path back to the preferred data

path.

Symmetric Devices

For Symmetric devices, there is no failback. The path is just added back into the load

balancing path pool.

Asymmetric Devices

You can specify two failback modes for asymmetric devices:

■ Automatic failback

■ Manual failback

Note – Automatic failback is only supported in a single-host environment.

You can configure the Sun StorEdge Traffic Manager software to automatically fail

back to the preferred data path when that path becomes operational. By default,

automatic failback is not enabled.

You can also manually fail back the data path for a storage device to its preferred

data path. First, ensure that the Sun StorEdge Traffic Manager software is configured

for manual failback.

The failback mode is set for the Sun StorEdge Traffic Manager software on a per

system basis. That is, setting the failback mode sets it for all devices attached to the

current host.
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▼ Setting the Failback Mode

1. Choose Preferences from the File pull-down menu.

FIGURE 2-29 Choosing Preferences for the Failback Mode

2. In the Host Preferences dialog box, choose the desired failback mode from the
Failback Mode pull-down menu.

FIGURE 2-30 Setting the Failback Mode

3. Click OK for the selected item to take effect.

If you do not want to save the changes you made, click the Cancel button.
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If you want to see the factory default settings, click the Factory Defaults button. The

factory default will be displayed next to the Failback Mode label. The factory default

will not take effect unless you click the OK button.

Note – Be aware that by clicking the Factory Defaults button, you are also setting

the Logging level and Poll Rate to the factory default settings.

Setting the Poll Rate

The healthy path poll rate determines how often the Sun StorEdge Traffic Manager

software checks the status of paths that are not down or removed and are currently

available for I/O.

The unhealthy path poll rate determines how often the Sun StorEdge Traffic

Manager software checks the status of paths that are down. If failback mode is set to

automatic and the Sun StorEdge Traffic Manager software finds that the preferred

path is operational after polling, the Sun StorEdge Traffic Manager software fails

back to the preferred path.

The poll rate is set for the Sun StorEdge Traffic Manager software on a per system

basis. That is, setting the polling rate sets it for all devices attached to the current

host.

▼ Setting the Poll Rate

1. Choose Preferences from the File pull-down menu.

FIGURE 2-31 Choosing Preferences for Setting the Poll Rate
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2. In the Host Preferences dialog box, choose the desired poll rate from the Poll Rate
pull-down menu.

FIGURE 2-32 Setting the Poll Rate

3. Click OK for the change to take effect.

If you do not want to save the change you made, click the Cancel button.

If you want to see the factory default setting, click the Factory Defaults button. These

factory defaults will not take effect unless you click the OK button.

Note – Be aware that by clicking the Factory Defaults button, you are also setting

the Logging level and Failback Mode to the factory default settings.



34 Sun StorEdge Traffic Manager 3.1 Software User’s Guide • October 2003



35

CHAPTER 3

Using the Sun StorEdge Traffic
Manager CLI Software

This chapter describes the uses of the Sun StorEdge Traffic Manager command line

interface (CLI) software.

The Sun StorEdge Traffic Manager command line interface described in this chapter

is named sstm . The sstm command has similar function to the Sun StorEdge

Traffic Manager GUI interface described in Chapter 2. The CLI enables you to collect

basic path and software state information and to manage path states and software

settings.

Topics in this chapter include:

■ “Command-Line Interface Options” on page 35

■ “sstm Command Operations” on page 37

Command-Line Interface Options

TABLE 3-1 contains an overview of all the options available for the sstm command.

TABLE 3-1 sstm Command Options

Command Option Description

sstm

None This is the default and displays

information about all devices

-v Displays information about all devices

(verbose)
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-d device_id Displays information about the

specified device

-d device_id -v Displays verbose information about

the specified device

-d device_id -r Restores all preferred paths for all

LUNs for the specified device

-l lun_id Displays information for a specified

LUN

-l lun_id -v Displays verbose information for a

specified LUN

-l lun_id -r Restores the preferred path for the

specified LUN

-l lun_id -m Displays statistics for the specified

LUN

-l lun_id -m -v Displays verbose statistics for the

specified LUN

-p name Queries information for the specified

path

-p name -v Queries verbose information for the

specified path

-p name -a Activates the specified path

-p name -e Enables the specified path (take out of

admin mode)

-p name -d Disables the specified path (place into

admin mode)

-p name -m Displays statistics for the specified

path

-p name -m -v Displays verbose statistics for the

specified path

-h name Query information for this HBA

-h -name -v Query verbose information for this

HBA

-h -name -e Enable all paths on this HBA (take out

of admin mode)

-h name -d Disable all paths on this HBA (place

into admin mode)

-P Displays public parameters

TABLE 3-1 sstm Command Options (Continued)

Command Option Description
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For a description of the specific fields shown in these examples, see “Description of

Specific Fields” on page 4.

In the case of a failure of a command, a variety of meaningful messages are returned.

To view this list of error messages, see Chapter 4.

sstm Command Operations

The following examples show the operations of the sstm command and the

expected output.

Topics in this section include:

-P -r Restores default settings

-P -i seconds Sets the healthy path poll rate to the

specified number of seconds (from 2

through 60 seconds)

-P -b seconds Set the unhealthy path poll rate to the

specified number of seconds (from 2

through 60 seconds)

-P -l hex_value Sets the following log levels to

determine what information to log:

• 0x00 = no logging

• 0x01 = data path changes

• 0x02 = internal errors

• 0x04 = critical errors

• 0x08 = informational messages

• 0x10 = caution messages

• 0x1f = log everything

-P -a integer Sets the following integers to enable or

disable auto failback:

• 1 = enable

• 0 = disable

-S Suspends command return until a state

change occurs (for example, path up or

down.

-C Cancel the suspend command and

return to the user.

TABLE 3-1 sstm Command Options (Continued)

Command Option Description
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■ “Obtaining a Default Report” on page 38

■ “Device Reports” on page 40

■ “LUN Reports” on page 42

■ “Path Reports” on page 44

■ “Getting Software Settings” on page 51

■ “Changing Software Settings” on page 51

■ “The Suspend Command” on page 52

■ “The Cancel Command” on page 52

Obtaining a Default Report

This section shows the default report that is created by typing the sstm command

with no options specified. The following example is a sample output taken from a

Microsoft Windows host. There are two storage devices with two LUNs and each is

exposed to this host. All LUNs are attached to the host through two redundant
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paths. The output from other operating systems is nearly identical with the

exception of the operating system device names, path names, and HBA names

presented

CODE EXAMPLE 3-1 sstm Command Default Report

sstm

Device: storage device
  Device Name:       t3mojo.Central.Sun.COM
  Failover Capable:  yes
  Device Desc:       Sun StorEdge T3B Disk Array
  Unique Id:         60020f20000069960000000000000000
  IP Address:        172.20.24.100
  Firmware Revision: 0201

  LUN: \\.PhysicalDrive4
    Unique Id:                 60020f20000069963ee74a2a000829f6
    Serial Number              00535030
    Capacity:                  5.00GB
    State:                     UP
    Pathing Mode:              Asymmetric-MPXIO

    Paths to this LUN:
                                                              Cntr
    * Path                HBA                 State           Pref
    - ------------------- ------------------- --------------- ---
      2,1,0,6             \\.\Scsi2:          ACTIVE          yes
    ! 3,1,0,6             \\.\Scsi3:          ADMIN           no

  LUN: \\.PhysicalDrive3
    Unique Id:                 60020f20000069963edb185e00033644
    Serial Number              00210500
    Capacity:                  10.00GB
    State:                     UP
    Pathing Mode:              Asymmetric-MPXIO

    Paths to this LUN:
                                                              Cntr
    * Path                HBA                 State           Pref
    - ------------------- ------------------- --------------- ---
    ! 2,1,0,3             \\.\Scsi2:          ADMIN           no
      3,1,0,3             \\.\Scsi3:          ACTIVE          yes
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Device Reports

This section describes the Device Reports that can be performed on a storage device.

For the device report, a storage device is defined as a collection of LUNs contained

by a specific storage product (for example, a Sun StorEdge 6120 or 6020 array).

The report generated by the sstm -d device_id is a subset of the default report

that shows only the information about the device specified and its associated LUNs

and paths.



Chapter 3 Using the Sun StorEdge Traffic Manager CLI Software 41

CODE EXAMPLE 3-2 Specific Device Report

sstm -d 60020f20000069960000000000000000

Device: storage device
  Device Name:       t3mojo.Central.Sun.COM
  Failover Capable:  yes
  Device Desc:       Sun StorEdge T3B Disk Array
  Unique Id:         60020f20000069960000000000000000
  IP Address:        172.20.24.100
  Firmware Revision: 0201

  LUN: \\.PhysicalDrive4
    Unique Id:                 60020f20000069963ee74a2a000829f6
    Serial Number              00535030
    Capacity:                  5.00GB
    State:                     UP
    Pathing Mode:              Asymmetric-MPXIO

    Paths to this LUN:
                                                              Cntr
    * Path                HBA                 State           Pref
    - ------------------- ------------------- --------------- ---
      2,1,0,6             \\.\Scsi2:          ACTIVE          yes
    ! 3,1,0,6             \\.\Scsi3:          ADMIN           no

  LUN: \\.PhysicalDrive3
    Unique Id:                 60020f20000069963edb185e00033644
    Serial Number              00210500
    Capacity:                  10.00GB
    State:                     UP
    Pathing Mode:              Asymmetric-MPXIO

    Paths to this LUN:
                                                              Cntr
    * Path                HBA                 State           Pref
    - ------------------- ------------------- --------------- ---
    ! 2,1,0,3             \\.\Scsi2:          ADMIN           no
      3,1,0,3             \\.\Scsi3:          ACTIVE          yes
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In addition to the ability to limit a report to a specific device, the -d option can be

used with the additional argument of -r to restore all the preferred paths to all the

LUNs in this system.

If the command restores all the LUNs on the device to their preferred path:, a

successful message is displayed.

The following is an example of a command completing successfully:

In the case of a failure, a variety of other messages are returned. A list of all

messages is described in Chapter 4.

LUN Reports

This section describes the LUN reports and the types of reports the options produce

when they are used with this command. The report generated by the sstm -l
lun_id command is a subset of the default report that shows only the information

about the specified LUN and its associated paths.

The following is an example of the output from this option

CODE EXAMPLE 3-3 Command Completing Successfully

sstm -d 60020f20000072250000000000000000 -r
The operation completed successfully. (0)

CODE EXAMPLE 3-4 Specific LUN Report

sstm -l 60020f20000077043f1c0b0800007720
  LUN: \\.PhysicalDrive3
    Unique Id:                 60020f20000077043f1c0b0800007720
    Serial Number              00030496
    Capacity:                  11.00GB
    State:                     UP
    Pathing Mode:              Asymmetric-MPXIO

    Paths to this LUN:
                                                              Cntr
    * Path                HBA                 State           Pref
    - ------------------- ------------------- --------------- ---
      3,0,0,1             \\.\Scsi3:          ACTIVE          no
    ! 3,0,10,1            \\.\Scsi3:          PASSIVE         yes
    ! 4,0,16,1            \\.\Scsi4:          PASSIVE         yes
      4,0,19,1            \\.\Scsi4:          ACTIVE          no
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In addition to the ability to limit a report to a specific LUN, the -l option can be

used with the additional argument of -r to restore all the preferred paths to a LUN.

The following is an example using the -v (Verbose) option.

The -l option of the LUN commands also has the option similar to the Device

command to restore a LUN’s path to the preferred controller. The following example

is an example of using the -l option.

The following is an example of a command completing successfully.

CODE EXAMPLE 3-5 With the Verbose Option Specified

sstm -l  60020f20000069963edb1844000d9214 -v

  LUN: \\.PhysicalDrive2
    Unique Id:                 60020f20000069963edb1844000d9214
    Serial Number              00889364
    Capacity:                  10.00GB
    State:                     UP
    Pathing Mode:              Asymmetric-MPXIO

    Paths to this LUN:
                                                              Cntr  In
    * Path                HBA                 State           Pref
Use
    - ------------------- ------------------- --------------- ---  ---
-
      2,1,0,2             \\.\Scsi2:          ACTIVE          yes  yes
        state:ACTIVE numOut=0 flags:0x7
      3,1,0,2             \\.\Scsi3:          PASSIVE         no   no
        state:PASSIVE numOut=0 flags:0x2

sstm -l 60020f20000072250000000000000000 -r
The operation completed successfully. (0)
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The -m option returns statistical information about the LUN. The following is an

example from this option:

Path Reports

The basic Path Reports returns information about a specific path. The report

generated by the sstm -p name command is a subset of the default report that

only shows the information about the path specified.

This report contains a nexus name for the HBA to storage device controller. In these

examples, it is noted by 3,0,10,1 . The nexus name is defined by the failover

software.

The following is an example of the Path Report:

Activating a Data Path

The -a Path command option activates a path that is passive. When this option is

used, a message indicating success is sent if the command is successful. Otherwise,

an error message is issued. A list of all messages is described in Chapter 4.

CODE EXAMPLE 3-6 With Statistical Option Specified

sstm -l 60020f20000072253dad916300061f41 -m -v
LUN Statistics:

LUN: 60020f20000072253dad916300061f41
Host Requests: 198
Outstanding IO: 0
Blocks Transferred: 1682
IO Errors: 0
Temp Dropouts: 0
HW Dropouts: 0
Full Dropouts: 0

CODE EXAMPLE 3-7 Path Report Output

sstm -p 3,0,10,1
                                                              Cntr
    * Path                HBA                 State           Pref
    - ------------------- ------------------- --------------- ---
    ! 3,0,10,1            \\.\Scsi3:          PASSIVE         yes
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The following example of the -a option builds on the sstm -p example. It uses the

-a option to activate a path. The success of the command can be verified by running

a second Path Report to list the results. In the second Path Report, the State status

is reported as Active .

Putting a Path into Admin Mode

The -d Path command option puts a path into an admin mode. This option is used

to stop all I/O on a path and can be used to help isolate problems in a configuration.

This example also builds on the basic Path Report example. After issuing the Path

command with the -d option, the path becomes disabled and inactive. A warning

character(! ) is also placed in the left column noting that the path is in admin mode

and not down. If the path was down, an X would be placed in the column. Only a

single character (for example, ! or x ) can be placed in the left column.

Taking a Path Out of Admin Mode

The -e Path command option takes a path out of admin mode. After the Path

command is issued with the -p option, the path becomes available, but not active.

CODE EXAMPLE 3-8 Activating a Data Path

sstm -p 3,0,10,1 -a
The operation completed successfully. (0)

sstm -p 3,0,10,1
                                                              Cntr
    * Path                HBA                 State           Pref
    - ------------------- ------------------- --------------- ---
      3,0,10,1            \\.\Scsi3:          ACTIVE          yes

CODE EXAMPLE 3-9 Putting A Path Into Admin Mode

sstm -p 3,0,10,1 -d
The operation completed successfully. (0)

sstm -p 3,0,10,1
                                                              Cntr
    * Path                HBA                 State           Pref
    - ------------------- ------------------- --------------- ---
    ! 3,0,10,1            \\.\Scsi3:          ADMIN           yes
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■ For symmetric devices, the path becomes active immediately if not broken.

■ For asymmetric devices, like the Sun StorEdge T3+, if the path is the preferred

path and Auto Failback is on, the path becomes active immediately.

This status is shown by issuing the sstm command without options.

Getting Path Statistical Information

The Path command -m option returns the statistical information for a specific path.

Getting HBA Reports

The basic -h option returns information about a specific HBA. The specific

information returned contains the Vendor name, Product Id, Firmware Version, Port

and Node WWNs of the HBA, and HBA driver file name.

The reports also contains all the paths seen only by the particular HBA. The listing is

similar to the Path reports.

CODE EXAMPLE 3-10 Taking a Path Out Of Admin Mode

sstm -p 3,0,10,1 -e
The operation completed successfully. (0)

sstm -p 3,0,10,1
                                                              Cntr
    * Path                HBA                 State           Pref
    - ------------------- ------------------- --------------- ---
      3,0,10,1            \\.\Scsi3:          ACTIVE          yes

CODE EXAMPLE 3-11 Returning Statistical Path Information

sstm -p 3,0,10,1 -m -v
Path Statistics
  Path:               3,0,10,1
  Host Requests:      6266756
  Outstanding IO:     1
  Blocks Transferred: 702227085
  IO Errors:          154
  HW Dropouts:        0
  Full Dropouts:      53
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Note – The paths might belong to different devices.

CODE EXAMPLE 3-12 Returning Information About a Specific HBA

sstm -h \\.\Scsi4:
Name: Qlogic 2230 Fibre-Channel Adapter
Firmware Revision: 5.12
Node WWN: 00000000000000000000000000000001
Port WWN: 00000000000000000000000000000011
Driver File Name: qla23xx

Cntr
* Path HBA State  Pref
- ------------------ --------------- ------- ------

4,1,0,6 \\.\Scsi4: ACTIVE no
4,1,0,5 \\.\Scsi4: ACTIVE no
4,1,2,1 \\.\Scsi4: ACTIVE no
4,1,2,0 \\.\Scsi4: ACTIVE no
4,1,1,0 \\.\Scsi4: ACTIVE yes
4,1,1,1 \\.\Scsi4: ACTIVE yes
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It is also possible to enable (-e ) or disable (-d ) all the paths to a particular HBA. The

following example shows disabling all the paths to a particular HBA and placing the

paths in admin mode. The output after the disable command looks like the following

example:

CODE EXAMPLE 3-13 Placing all Paths to a Particular HBA in Admin Mode

sstm -h \\.\Scsi3: -d
  pathId:3,0,0,1  status:The operation completed successfully.
  pathId:3,0,10,1  status:The operation completed successfully.
  pathId:3,0,0,0  status:The operation completed successfully.
  pathId:3,0,10,0  status:The operation completed successfully.
  pathId:3,0,3,3  status:The operation completed successfully.
  pathId:3,0,21,3  status:The operation completed successfully.
  pathId:3,0,4,0  status:The operation completed successfully.
  pathId:3,0,20,0  status:The operation completed successfully.
  pathId:3,0,1,0  status:The operation completed successfully.
  pathId:3,0,13,0  status:The operation completed successfully.
  pathId:3,0,1,1  status:The operation completed successfully.
  pathId:3,0,13,1  status:The operation completed successfully.
  pathId:3,0,2,0  status:The operation completed successfully.
  pathId:3,0,5,0  status:The operation completed successfully.

The operation completed successfully. (0)
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CODE EXAMPLE 3-14 Disabling All Paths To a Specific HBA

sstm -h \\.\Scsi3:

HBA:               QLogic Corporation 2300 Fibre-Channel Adapter
Name:              \\.\Scsi3:
Firmware Revision: 3.01.20
NodeWWN:           200000e08b07642e
PortWWN:           210000e08b07642e
Driver File Name:  ql2300.sys
                                                              Cntr
    * Path                HBA                 State           Pref
    - ------------------- ------------------- --------------- ---
    ! 3,0,0,1             \\.\Scsi3:          ADMIN           no
    ! 3,0,10,1            \\.\Scsi3:          ADMIN           yes
    ! 3,0,0,0             \\.\Scsi3:          ADMIN           yes
    ! 3,0,10,0            \\.\Scsi3:          ADMIN           no
    ! 3,0,3,3             \\.\Scsi3:          ADMIN           no
    ! 3,0,21,3            \\.\Scsi3:          ADMIN           yes
    ! 3,0,4,0             \\.\Scsi3:          ADMIN           yes
    ! 3,0,20,0            \\.\Scsi3:          ADMIN           yes
    ! 3,0,1,0             \\.\Scsi3:          ADMIN           yes
    ! 3,0,13,0            \\.\Scsi3:          ADMIN           yes
    ! 3,0,1,1             \\.\Scsi3:          ADMIN           yes
    ! 3,0,13,1            \\.\Scsi3:          ADMIN           yes
    ! 3,0,2,0             \\.\Scsi3:          ADMIN           yes
    ! 3,0,5,0             \\.\Scsi3:          ADMIN           yes
The operation completed successfully. (0)
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If the verbose (-v ) option is used, the output looks like the following example:

CODE EXAMPLE 3-15 Disabling All Paths To a Specific HBA Using -v Option

sstm -h \\.\Scsi3: -v

HBA:               QLogic Corporation 2300 Fibre-Channel Adapter
Name:              \\.\Scsi3:
Firmware Revision: 3.01.20
NodeWWN:           200000e08b07642e
PortWWN:           210000e08b07642e
Driver File Name:  ql2300.sys
                                                              Cntr  In
    * Path                HBA                 State           Pref
Use
    - ------------------- ------------------- --------------- ---  ---
-
    ! 3,0,0,1             \\.\Scsi3:          ADMIN           no   no
        state:ADMIN numOut=0 flags:0x2
    ! 3,0,10,1            \\.\Scsi3:          ADMIN           yes  no
        state:ADMIN numOut=0 flags:0x6
    ! 3,0,0,0             \\.\Scsi3:          ADMIN           yes  no
        state:ADMIN numOut=0 flags:0x6
    ! 3,0,10,0            \\.\Scsi3:          ADMIN           no   no
        state:ADMIN numOut=0 flags:0x2
    ! 3,0,3,3             \\.\Scsi3:          ADMIN           no   no
        state:ADMIN numOut=0 flags:0x2
    ! 3,0,21,3            \\.\Scsi3:          ADMIN           yes  no

state:ADMIN numOut=0 flags:0x6
    ! 3,0,4,0             \\.\Scsi3:          ADMIN           yes  no
        state:ADMIN numOut=0 flags:0x6
    ! 3,0,20,0            \\.\Scsi3:          ADMIN           yes  no
        state:ADMIN numOut=0 flags:0x6
    ! 3,0,1,0             \\.\Scsi3:          ADMIN           yes  yes
        state:ADMIN numOut=0 flags:0x7
    ! 3,0,13,0            \\.\Scsi3:          ADMIN           yes  no
        state:ADMIN numOut=0 flags:0x6
    ! 3,0,1,1             \\.\Scsi3:          ADMIN           yes  no
        state:ADMIN numOut=0 flags:0x6
    ! 3,0,13,1            \\.\Scsi3:          ADMIN           yes  no
The operation completed successfully. (0)
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Getting Software Settings

If the sstm -P command is issued without specifying options, a report is returned

of all the software parameters plus the version of the failover software.

Changing Software Settings

The -P command, with no sub commands, returns a report of all the driver

parameters plus the failover driver version. Any of the parameters can be changed

by using their respective subcommittees.

The following sstm commands can be used to change the software settings

displayed by the sstm -P command:

CODE EXAMPLE 3-16 Returning a Report About All Software Parameters

sstm -P
Driver Public Parameters

Driver Version: 3.0.0.105
Healthy Path Poll Rate: 30 (seconds)

Unhealthy Path Poll Rate: 30 (seconds)
Auto Failback: 0 (off)

 Log Level: 0x00 (none)

TABLE 3-2 Changing Software Settings

Supported Subcommittees Action

-P -r Restores default settings

-P -i seconds Sets healthy path poll rate (2 through 60 seconds)

-P -b seconds Sets unhealthy path poll rate (2 through 60 seconds)

-P -l hex value Sets the log level to any of the following:

• 0x00 = no logging

• 0x01 = data path changes

• 0x02 = internal errors

• 0x04 = critical errors

• 0x08 = informational messages

• 0x10 = caution messages

• 0x1f = log everything

-P -a integer Enables or disables auto failback

• 1 = enable

• 0 = disable
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A complete list of all the command options and their explanations is found in

TABLE 3-1.

The Suspend Command

The sstm -S command blocks or stalls the return of the command and does not

return to the user until some form of path state change occurs. For example, if a path

goes down, comes back online, is disabled, the command initiates a return to the

user.

This is a very useful command for scripting because you can create your own form

of logging by making a script that issues a sstm command default report, then a

sstm -S command in a loop.

The Cancel Command

The cancel command cancels the suspend command.

CODE EXAMPLE 3-17 The Suspend Command

sstm -S
C:>

CODE EXAMPLE 3-18 The Cancel Command

sstm -C
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CHAPTER 4

Error Return Messages

The folowing table contains all the return messages from the command line interface

to the initiator of the command. To obtain a number value for these returns echo

%ERRORLEVEL%after the sstm command completes. The echo response will be

integers.

TABLE 4-1 Error Return Codes and Meanings

Code Meaning

00 The operation completed successfully.

100 The operation contained an invalid parameter.

101 An I/O error occurred during the operation.

102 The operation did not complete within the specified time.

103 The specified HBA could not be found or does not exist.

104 The specified device could not be found or does not exist.

105 The specified LUN could not be found or does not exist.

106 The specified path could not be found or does not exist.

107 The specified device was busy and could not accept the request.

108 The host OS has no memory left to allocate.

109 An internal error was encountered during the operation.

110 No supported devices were detected.

111 There are no alternate paths available to the device.

112 The specified path could not be enabled.

113 The specified path is already the active path.

114 The specified path is down or offline and is currently not available.

115 The selection of the specified path failed.
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116 An invalid state change was attempted for the specified path.

117 The preferred path is down or offline and is currently not available.

118 An illegal or out-of-range command was specified.

119 The specified SCSI pass-through command failed.

120 The buffer specified was too small for the operation.

121 The restore operation failed.

122 A reservation conflict was encountered during the operation.

123 The operation is not supported.

124 A reboot is required.

125 The operation failed for some paths.

TABLE 4-1 Error Return Codes and Meanings (Continued)

Code Meaning
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Glossary

active path A path that is healthy and ready for I/O.

array A Sun StorEdge array that contains an internal RAID controller and disk drives

with Fibre Channel connectivity to the data host.

failback The process of making a LUN’s preferred controller the active controller. Also

known as restore.

failover The process of sending a failover command down a passive path to change the

active controller for a LUN.

host bus adapter (HBA)
A controller board that connects the host computer bus and the FC-AL that

manages the transfer of information between the two channels.

logical unit number
(LUN) A piece of logical storage presented by the device to the host.

passive path For an asymmetric device, a path to a passive controller. Can be made active by

sending a failover command.

preferred controller On an asymmetric device, the default active controller for a LUN.

restore The process of making a LUN’s preferred controller the active controller. Also

known as failback.

volume One or more drives configured into a RAID group. May be sliced into smaller

LUNs to be presented to the host.

worldwide name
(WWN) Unique number assigned to each device on a Fibre Channel loop.
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